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Morning Assignments

See kiosk on electronic blackboard for more information.

Stock Portfolio: Check and print. Key the current price onto the Excel template. Save and close.

Individual Journal Writing: Write your journal response before class, print a copy and bring with you to class. “How will you evaluate your students in a technology connected lesson? How will you assess the effectiveness of the lesson?”
Group Sharing: Share your journal response in your small group. Pick a spokesperson to share with the whole group (pick a different person each day).

Learning Styles Inventory

Whole-group Discussion: Take a learning style survey OR take a personality profile on the Web.

Go to URL:

http://ttc.coe.uga.edu/surveys/disclaimer.html?LearningStyleInv.html
http://www.keirsey.com
Setting the scene for today’s activities:

· Look at Lesson Plan, Questionnaire, Evaluation Form, and Storyboard handouts for Influential People activity.

· Complete three tasks: a) use a digital camera to take pictures of each other, b) use a scanner to scan the picture you brought of your influential person, and c) use the Internet to complete the influential person questionnaire.

· Classroom Management Strategy: Excel Wall Chart. Check off your name as you complete the activities.

Influential People Research and Multimedia Presentations

Whole group Techie Moment: Each One, Teach One: Digital Camera and Scanner

· One volunteer from each school is responsible for learning the camera and scanner.

· Volunteers from each group show the rest of their school team how to use each piece of equipment.

· Individual Activity: Those who are waiting to learn how to use the camera and scanner will be searching the Internet or using CD-ROM Encyclopedias to find information on your influential person and filling in the questionnaire handout.

· Bookmark a good picture of your influential person.

Whole group Techie Moment: Saving a Graphic Image. Save the graphic of your influential person to disk and also to a common networked folder for later use. Use the name of the person as the filename.

Whole group Activity: Create PowerPoint presentations.

· Include the digital picture of yourself on the title page, the scanned and Internet pictures anywhere, and clipart to fill in spaces and make the presentation more attractive.

· Create an organizational chart to represent the birth date, death date, and 4 important events in the person’s lifetime.

· Reference the PowerPoint storyboard example, to use as a guide and the Step-by-Step directions.

Whole group Instruction: PowerPoint

· Slide transitions, builds to text, animations to clipart, etc.

· With any remaining time, put finishing touches on your presentations. Those who finish early can begin the first supplemental activity and/or write a lesson plan for using PowerPoint in their curriculum.

· Save a copy of your presentation to disk and to a network folder so they can be shown to the class.

Whole group Instruction: Timeline.

· See lesson plan for using TimeLiner.

· Go through steps 1-5 of Influential People Timeline Step-by-Step handout.

Presentations: As each person’s presentation is shown, enter the names and birth and death dates for all influential people into your timeline. TimeLiner will automatically rearrange the events so they are in order.

Whole group Instruction: TimeLiner, continued. Finish the step-by-step handout of Influential People Timeline to add graphics and finishing touches to the timeline.

Closure Activity

Think-Pair Share. Ideas for sharing may include major points learned, confusing or troublesome points, best (and/or) worst activities, curriculum adaptations for material presented.
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 TC “Technology Connected Lesson Plan – Influential People Research”Technology-Connected Lesson Plan

	Lesson Plan Number

(Check one box)
	1
	2
	3
	4

	
	
	
	
	


	Lesson Title:
	Influential People Research and Multimedia Presentations

	Grade Level/Subject Area:
	All Subjects, 9-12



	Student Profile: 
	Number of Students: 15-20

	
	Number of Students with Special Needs: varies

	
	Area of Specialties: ADD, ADHD. Vision Impaired or Hearing Impaired

	Performance Objectives:


	· Given research CDs and Internet, students will research at least five points on an influential person and communicate their findings in a PowerPoint with at least six slides.

· Using the digital camera and scanner, the students will use at least two pictures from that source in their PowerPoint.

	Curricular Connections: (QCC/IEP/Local or National Standards)
	· LA; Applied Comm. 32. Experiences a variety of non-print resources as part of the study of technical and business applications; creates multimedia presentations.

· SS; US History. 16. Develops a beliefs and values profile.

· SS; US History. 37. Traces the events and identifies influential personalities of the Civil Rights era from 1947 to the present.

· SS; Current Issues. 2. Identifies sources of information - the media, computer networks. -distinguishing fact from opinion…-validates sources as to their authority.

· Sci; Biology. 2. Demonstrates appropriate use of reference sources to access, analyze, evaluate, and present information related to research problems.

· Sci; Biology. 2.1. Demonstrates appropriate use of reference and media sources to find information.

· Math; Problem Solving. 2. Communicates mathematical ideas by using language and symbolism: Asks clarifying and extending questions related to mathematics about which they have read or heard.

· Math; Problem Solving. 3. Investigates connections within mathematics; views mathematics as an integrated whole rather than an isolated set of topics.

	Assessment:
	· Students will receive individual grades for the information gathered on the Fact-Gathering Questionnaire.

· Students will receive a grade for the presentation.

· A Criteria/Evaluation assessment rubric will be used to assign points.

	Technology Connections:
	· Uses digital camera and scanner technologies to capture pictures for use in multimedia presentation.

· Uses Internet and CD-Rom technologies to gather information for presentations.

· Uses PowerPoint software to create classroom presentations based on research found.

	Materials:
	· Digital camera(s)

· Scanner

· PowerPoint

· Internet Connection

· Reference CDs

· Handouts: PowerPoint Assessment form, PowerPoint Guidelines, Fact-Gathering Questionnaire, Quick Tip handouts for using scanner and digital cameras

	Related URLs:
	No URL used specifically for this lesson 

	Procedures:


	Whole Group:

Teacher will present sample PowerPoint and students will take notes on particular parts they would like to incorporate into their presentation.

	
	Small Group:

Students will rotate in small groups and use digital cameras to take pictures of each other and the scanner to scan pictures of their chosen influential person.

	
	Cooperative Group:

	
	Individual:

· Students will fill out fact-finding questionnaires about their chosen influential person by searching the Internet and using reference CDs.

· Students will save graphics from the Internet onto disk.

· Students will create PowerPoint presentations that include the digital and scanned pictures and the information gathered for the fact-finding questionnaire.

	Classroom Management:


	Technology Management:

Students will use the class list and check off the parts of the assignment that are completed. There will be a class list with three parts of the assignment: scanner, camera, and research.

	
	Instructional Groups:
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Jot down some thoughts to answer these questions; then write a short paper to discuss them fully.

How are the beliefs and values of the person you researched similar to yours?

How is the person you researched different from you?

How was the lifestyle of the person you researched as he/she was growing up different from your lifestyle today?

What haven’t you learned about this person that you would still like to know?
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PowerPoint Evaluation
Name
Period


Influential Person


Criteria
Point Value
Pts. Earned

· Includes all information on fact sheet
40 points



· Includes a time line of 5 important dates


created in Organizational Chart
10 points



· Includes a title page
5 points



· Includes a digital picture of the author


of PowerPoint presentation
5 points



· Includes a scanned picture of the


influential person
5 points



· Includes three additional graphics from


Clipart and Internet
5 points



· Uses proper spelling, punctuation,


word usage, etc.
10 points



· Last slide cites resources used
10 points



· Follows guidelines for whole group


presentations (See attached guidelines)
10 points




TOTAL POINTS:
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Using a Computer with a Scan Converter/TV
1. Use a minimum of 36-point font size.

2. Have a maximum of 8 lines of text.

3. Have approximately 5-7 words per line.

4. Use dark text on a light background or vice versa – but make it an obvious contrast.

5. Fill the page! If you only have 3 lines, increase the font size and add pictures.

6. Use a Sans Serif font (no curves) such as Arial, Courier, or Helvetica.

7. Use Bold text for extra thickness.

8. Use clip-art, drawing tools, and other graphics to make the slides more interesting (and possibly even improve retention).

9. Be colorful!

10. Use the same slide transition between slides, and make them fast transitions. If you add sounds to transitions, make the sounds short.

11. Number the slides so people can refer to particular ones.

12. Don’t use italics.

13. Don’t use all CAPS, except in titles.

14. Don’t use red text - it bleeds (no pun intended).

15. Don’t overdo the use of sounds.
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(Consumable Copy)
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PowerPoint Storyboard Example
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Step-by-Step
16. Launch PowerPoint: Click on the Start button and highlight Programs. Highlight Microsoft and then highlight and click Microsoft PowerPoint.
17. Click OK after you read the Tip of the Day, if necessary.
18. On the task pane at the right, click General templates.
19. At the Templates window, click once on the tab labeled Design Templates. Scroll through the choices of templates. To preview a design, click once on the icon for it and the preview will appear on the right side of the screen. Select a template that appeals to you and click OK.
20. PowerPoint changes the task pane to Slide Layouts.
21. Begin with a title slide. Select the first Slide Layout, Title Slide. Enter the following information:
Title: The Name of Your Influential Person
Subtitle: Your Name, Class
22. Insert your picture taken with the digital camera: Insert floppy disk into the A drive. From the Insert menu, choose Picture, then From File. Next to “Look in:” in the Insert Picture dialog box, click on the down arrow and select the A drive. Double-click on the file name for your picture.

23. Size/Move your picture: Size the picture by moving the cursor to any handle around the picture so that a double-arrow appears (handles will only appear if the picture is selected). Click and drag to the size desired. Move the picture by moving the cursor to the center of the picture so that a 4-way arrow appears. Click and drag to desired location.

24. Edit the text on your title slide: Select the title section. Highlight main title text. Click on the Font Color button on the Drawing Toolbar (usually across the bottom) to select an alternate color for the text. Use the Bold button and the pull down menus for the Font Style and Font Size on the Formatting Toolbar across the top to make additional alterations. Select the subtitle and make similar changes.

25. Save the slideshow: Choose File, Save from the menu. At the save dialog box, title the slideshow at the File Name prompt. Click on the down arrow at the Save In prompt and choose Desktop. Locate your folder and double click on it. Click Save.
26. Use appropriate layouts to present various facts that you have collected on the Fact-Gathering Questionnaire. This should take between 4-6 slides.

27. Insert the scanned picture and the picture you captured from the Internet onto the appropriate slides the same way as you did your digital picture: Insert, Picture, From File. Change drives and double-click on filename. Size and move as described in Step 8.

28. Add clipart to enhance slides: From the Insert menu, choose Picture, then Clip Art (or click the funny looking man button on the toolbar). The Clipart Gallery appears. Click on the category on the left side and the individual picture on the right (you may have to scroll down to see all the choices). Click the Insert button.

29. Add transitions to the slideshow:

30. Click once on the Slide Sorter View button in the lower left section of your monitor.

31. Click once on the first slide to select it.

32. Click on the drop down arrow on the task pane and click Slide Transition. Select a transition for the slide.

33. Click once on the second slide. Add a transition.

34. Add build effects for any slides with bulleted text:

35. Highlight bulleted text.

36. From the Task Pane, click the drop down arrow and choose Custom Animation.

37. Click Add Effect. Choose an entrance effect.

38. Under Effects, click on the down-arrow for Sound.

39. Click the drop down arrow beside the added event, and choose Effect Options. 

40. To build text automatically instead on a mouse click: Switch to the Timing tab. Beside Delay, click to add a number of seconds.

41. Click on the OK button when finished.

42. Test your slideshow: Choose View, Slide Show from the menu options. At the slide show dialog box, click Show. Preview the presentation to make sure it looks neat, is consistent, and follows the guidelines for proper font size, style, color, etc.

43. Save work again using the Save button (computer disk) on the Standard Toolbar.
44. Check and double-check your slide show for spelling (the spell check button is on the formatting toolbar), punctuation, and clarity. (Don’t forget to check the Assessment form to make sure you have included all the items and followed all guidelines.)
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Step-by-Step

Why pack and go?

1. The document you created is too big to fit on one disk.

2. The document you created contains graphics, sounds, or other objects brought it from an outside source, such as a CD-ROM or floppy disk, or from a networked drive that will not be available when you show your presentation later.

If neither of the above is true:

Do a Regular Save:

· Go to the File menu, choose Save As

· Change to the A drive by clicking on the down arrow next to “Save In” and choosing A: 3 1/2 floppy

· Name the document and click on Save

To Open the File Later:

· Open PowerPoint

· Click on the Open button (or go to File, Open)

· Change to the A drive

· Double-click on the filename

If either #1 or #2 above is true:

Do a Pack and Go:

· Note which objects from outside sources are on which slide for later reference.

· From the File menu, Choose Pack and Go.

· Go through the steps and click on the Next button after each step (there won’t really be any choices to make, except possibly to not include the viewer.)

· PowerPoint will copy objects used from outside sources into your presentation. If it has trouble finding a file, you may get a message asking you to help find it. Choose the correct drive and folder, and then double-click on the filename each time you are prompted to find an object.

· If PowerPoint cannot fit your compressed file onto one floppy disk, it will prompt you to insert another blank disk. Make sure you mark which is disk #1.

To Unpack the Presentation Later:

· Turn the computer on but do not open PowerPoint yet.

· From the Desktop, double-click on the My Computer icon.

· Double-click on the A drive icon to show the contents of the floppy disk.

· You’ll have two files showing: Pngsetup.exe and pres0.ppz. Double-click on the Pngsetup.exe file to start the unpacking process.

· The PowerPoint default is to unpack the document to the root of the C drive. This is fine. Click OK. You can always delete this document from the C drive later.

· You will always get a message that the C drive is not empty and if any file exists on C with the same name, it will be overwritten. Click OK.

· When PowerPoint is finished unpacking the document, it will ask if you want to open it now. If you are using the viewer because you do not have PowerPoint on this computer, click Yes. If you have PowerPoint, click No.

To Open the Presentation:

· Now that you have unpacked the document, open PowerPoint.

· From the beginning dialog box, choose Open An Existing Presentation, Click OK.

· Change to the C drive, and scroll past all the folders to your document. Double-click on it to open it into PowerPoint.

· From the File menu, choose Save As. Change to the folder where you usually keep your files so you can access this document next time as you usually would.

To Delete the Old File From the Root of C:

· From the Start button on the desktop, go to Programs, then Windows Explorer.

· Click on the C drive on the left side to show the Contents of C on the right side.

· Find your document at the end of all the folders on C.

· Click on the filename to select it. From the File menu, choose Delete. Confirm with a Yes.

· Empty the Recycle Bin on the desktop by double-clicking on the icon and choosing Empty Recycle Bin.
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	Type of File
	Abbreviation
	What It Does

	Text
	.txt
	Text files are nothing more than pages of words.

	Graphics
	.bmp
	Bitmapped image—a bitmapped image is one made from an array of dots rather than continuous lines or areas. Standard bit-mapped graphics format used in the Windows environment.

	
	.gif
	Graphics Interchange Format— a bit-mapped graphics file format used by the World Wide Web, CompuServe and others. GIF supports color and various resolutions. It also includes data compression, making it especially effective for scanned photos. 

	
	.jpg
	Joint Photographic Experts Group—an industry committee that developed a compression standard for still images, JPEG refers to the graphics file format that uses this compression standard. 

	
	.tiff
	Tagged Image File Format—try to avoid using this file format because of the memory requirements. TIFF graphics can be any resolution, and they can be black and white, gray-scaled, or color. Files in TIFF format often end with a .tiff extension.

	
	.pic
	Short for Lotus Picture File, the graphics file format used to represent graphics generated by Lotus 1-2-3.

	Sounds
	.au
	When a Sun Microsystems or other Unix computer makes a noise, it does so in AU file format. Luckily, Macintosh and PC have browsers such as Netscape that can use the AU file format.

	
	.mid
	Musical Instrument digital Interface—pronounced “middy”, this connectivity standard enables you to hook together computers, musical instruments, and synthesizers to make and orchestrate digital sound. The term is used to describe the standard itself, the hardware that supports the standard, and files that store information that the hardware can use. MIDI files are like digital sheet music—they contain instructions for musical notes, tempo, and instrumentation—and are widely used in game soundtracks and recording studios.

	
	.wav
	WAV files are recordings that have been converted to a digital form. They may take up a great deal of memory.

	
	.mp3
	MP3 is the file extension for MPEG, audio layer 3, which is used in the compression of audio signals. Because MP3 files are small, they can easily be transferred across the Internet.

	Movie
	.avi
	AVI is the file format used by Video for Windows, one of several common video technologies used on personal computers. (Others are MPEG and QuickTime.) In AVI, picture and sound elements are stored in alternate interleaved chunks in the file.

	
	.mov
	MOV is a file extension found on the World Wide Web that denotes a movie or video file in QuickTime format. To play the movie after you download the file, your computer must support the QuickTime format.

	
	.mpeg
	Moving Pictures Experts Group—an industry committee that is developing a set of compression standards for moving images (such as film, video, and animation) that can be downloaded and viewed on a computer.


The formats listed above can be found in many different types of programs. However, some word processing programs have their own file formats, which won’t move easily into other programs. There are file conversion programs that can convert file types so that they can be shared by other programs. File conversion can also easily take place using scanner and paint programs.
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	Lesson Plan Number

(Check one box)
	1
	2
	3
	4

	
	
	
	
	


	Lesson Title:
	New World Explorers Timeline

	Grade Level/Subject Area:
	Social Studies (World History), English 9-12 and Mathematics

	Student Profile: 
	Number of Students: 25

	
	Number of Students with Special Needs: 1

	
	Area of Specialties: Visually impaired – supply larger monitor with larger display and keyboard with larger letters.

	Performance Objectives:


	· Students will participate in presentations by taking notes of at least one interesting fact per presentation with dates of when the person was born and died.

· Students will create a timeline with entries for the number of students giving presentations.

	Curricular Connections: (QCC/IEP/Local or National Standards)


	SS 11:
Explains the causes and effects of European exploration and colonization patterns in the New World.

SS 12:
Identifies changes resulting from the scientific and commercial revolutions.

SS 14:
Traces the development and decline of the European colonial empires in the Americas.

SS 41:
Makes timelines sequencing a series of events.

SS 42:
Uses annotated timelines to relate people and events.

SS 43:
Uses parallel timelines to compare developments in different areas in the same time frame.

LA 32:
Writing/Usage/Grammar: Is precise in punctuation, capitalization, spelling, and other elements of manuscript form.

LA 27: 
Critical Thinking: Constructs logical sequences and understands the conclusions to which they lead.

LA 30: 
Reading/Literature: Evaluates and synthesizes a variety of written materials.

LA 31: 
Reading/Literature: Reads critically, asks pertinent questions, recognizes assumptions and implications, and evaluates ideas within time constraints.

LA 38: 
Writing/Usage/Grammar: Synthesizes an idea from a text or an abstract concept and writes a response under time constraints.

LA 43:
Writing/Usage/Grammar: Engages in the research process using appropriate print, electronic, and interview sources; cites sources according to a standard style sheet (MLA, APA, or other).

LA 27: 
Writing/Usage/Grammar: Communicates ideas clearly in writing.

LA 38: 
Writing/Usage/Grammar: Writes for a variety of purposes including, but not limited to, technical (reports, memos, charts), business (letters, orders, requests), academic (compositions, essays, analyses), and personal (journals, stories).

LA 45:
Writing/Usage/Grammar: Evaluates and synthesizes a variety of written materials.

LA 5: 
Core Skills: Identifies, comprehends, and summarizes the main and subordinate ideas in a written work.

LA 7: 
Core Skills: Distinguishes between fact and opinion.

LA 10: 
Core Skills: Uses literal comprehension skills (e.g., sequencing, explicitly stated main idea).

LA 11: 
Core Skills: Uses inferential comprehension skills (e.g., predictions, comparisons, conclusions, implicitly stated main idea).

LA 15: 
Core Skills: Writes Standard American English sentences with correct verb forms, punctuation, capitalization, possessives, plural forms and other mechanics, word choice, and spelling.

LA 25: 
Core Skills: Composes and revises on a computer.

LA 27: 
Critical Thinking: Constructs logical sequences and understands the conclusions to which they lead.

Math 50: 
Probability and Statistics: Organizes, displays, and interprets data in tables, charts, and graphs.

Math 47:
Statistics: Gathers, organizes and interprets data, using appropriate representations such as tables and graphs.

Math 29: 
Representing and Analyzing Data: Organizes information using tables, charts, and a variety of graph types with appropriate labels and scales, and interprets such displays such as those found in public media.

	Assessment:
	· Students will use New World Explorers Assessment rubric
· Students will print timelines for classroom display/discussion.

	Technology Connections:
	Uses TimeLiner by Tom Snyder to create a timeline of the New World explorers.

	Materials:
	· Computer with TimeLiner

· Reference CD-ROMs or multimedia encyclopedia

· World history text

· New World Explorers Assessment rubric

	Related URLs:
	

	Procedures:


	Whole Group: Students will present their PowerPoint presentations while the audience takes notes on TimeLiner.

	
	Small Group:

	
	Cooperative Group:

	
	Individual:

· Students will research the New World explorers in a variety of media, including reference CD-ROM programs, CD-ROM multimedia encyclopedias, the Internet, and a variety of print resources, taking notes on dates and accomplishments.

· Students will record notes on presentations. Students will create a timeline displaying their research in TimeLiner.

	Classroom Management:


	Technology Management:

	
	Instructional Groups:


 TC “New World Explorers Assessment”New World Explorers Timeline

Assessment Form

Name
Pd.


Title of Presentation


Research
20 pts.


Completes Fact-Gathering worksheet
*E
G
N
U

Completes reference worksheet with works cited
E
G
N
U

Timeline
25 pts.


Sequences events in correct order
E
G
N
U

Can easily be seen by audience
E
G
N
U

Includes at least 5 graphics
E
G
N
U

Discussion Content
40 pts.

Explains cause & effect of colonization/exploration
E
G
N
U

Discusses changes caused by scientific/commercial

revolutions 
E
G
N
U

Traces development to decline of empire/civilization
E
G
N
U

Answers audience questions sufficiently
E
G
N
U

Presentation Technique
20 pts.


Speaks clearly and enunciates well
E
G
N
U

Speaks at a good pace
E
G
N
U

Uses a minimum of interrupters (i.e., uh, um, OK, etc.) 
E
G
N
U


Total Points:


*KEY: E = Excellent, G = Good/Satisfactory, N = Needs some work, U = Unsatisfactory
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Timeline Example

From Conception to Birth

Timeline view condensed to fit one page
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List view with added graphic

Timeline Example

History of Rock and Roll
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Timeline Example

Martin Luther King, Jr.’s Accomplishments
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 TC “Influential People Timeline Step-by-Step”Influential People Timeline

Step-by-Step

45. Start the program TimeLiner.

46. Select New and then Standard.

47. From the menu bar choose Format, Use Event Range.

48. Enter your data in the Start, End, and What columns. Tab to move from one column to the next. Press Enter to get a new blank line.

49. When you are done entering your data, select File and Save. Change to Drive A.

50. Click on the Banner view button.

51. Select File, Print Setup and choose Landscape.

52. If desired, move the entire timeline up or down by clicking on the bottom left edge of the line and dragging it to its new position.

53. Select Format and Clean Up Flags.

54. Select Edit and New Title. Type in Influential People.

55. Click and drag to move the title to the desired position.

56. Select Format and Set Title Font to change the title font.

57. Select File and Save again.

58. Minimize TimeLiner. Open the Word document that contains the pictures of all the influential people that were saved from the Internet.

59. Click one time on any graphic. Use Ctrl + C to copy it.

60. Maximize TimeLiner. Use Ctrl + V to paste the graphic. Click and drag to move to the desired position. Click and drag any event flags you want to move.

61. Repeat copying and pasting graphics until you are satisfied with the appearance of your timeline.

62. Don’t forget to save your timeline again! To print, select File and Print.
Hint: If you plan to import your timeline into PowerPoint or Word, make sure to change the font to 12 point in TimeLiner first so it won’t import so big.

 TC “Reflection: Think-Pair Share”Reflection
Think-Pair Share

(Consumable Copy)

Think-Pair Share. Ideas for sharing may include major points learned, confusing or troublesome points, best (and/or) worst activities, curriculum adaptations for material presented.

Major Points Learned

1. 


2. 


3. 


Confusing or Troublesome Points
4. 


5. 


6. 


Best (and/or) Worst Activities

7.


8.


9.


Curriculum Adaptations

10.


11.


12.


Reflection

Think-Pair Share

Think-Pair Share. Ideas for sharing may include major points learned, confusing or troublesome points, best (and/or) worst activities, curriculum adaptations for material presented.
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Confusing or Troublesome Points
4. 


5. 


6. 


Best (and/or) Worst Activities

7.


8.
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 TC “Assignments”Assignments

· Check your email and reply before the next class.

· Compose a journal entry in Microsoft Word. You will find the topic of the journal entry in the Day 5 Agenda. Print your journal entry and bring it to class with you. Also, send this journal entry to your instructor via email attachment. Instructions on how to send an email attachment are in Day 1.

· Bring your PowerPoint presentation back on Day 7 to learn how to save it as an HTML document and post it on the Web.

· The next technology-connected lesson plan with student work is due next class.

· (Optional) Practice saving your presentation to disk as a Pack ‘n Go. Directions are in the notebook.

Lesson Plan 3: The third lesson plan will be created and used between Day 4 and Day 5 of InTech training. It is due when you arrive for Day 5. It will include:

· Name of Participant

· School

· Lesson Title

· Subject/Topic Area

· Performance Objective

· QCC Standards

· Technology Connection

· Procedures (Include detailed descriptions of lesson plan requirements i.e. individual student activity)

· Assessment

· Materials/Technology Needed

· One new classroom management strategy

· One technology-connected small group cooperative learning activity

· Groups divided into teams of 4-6 students

· Each student will need a job description within the group

· Groups should be made up of heterogeneous grouping

Have a Journal Article to share if it is your turn to do so on Day 5.

 TC “Formatting MLA Style Papers Step-by-Step”Supplemental Activity

Formatting MLA Style Papers

Step-by-Step

63. Start Word. Go to File, Open and locate the file named MLA no format. This is a sample English paper on heroes in William Faulkner’s fiction. We will format it in MLA style.

64. First, set the margins to one inch all the way around. Select File, Page Setup, and under the Margins tab, enter 1” for Top, Bottom, Left, and Right.

65. Next, set the entire document for left alignment and double-spacing. Highlight the entire document by selecting Edit, Select All. Then click on Format, Paragraph. Under Alignment, click on the arrow for the drop-down menu and select Left. Under Line spacing, click on the arrow for the drop-down menu and select double.

66. Click “out of trouble” anywhere in the white space of the document. There is now an extra space between the date and the title. Position your cursor in this space and press the Delete key to remove it.

67. To center the title, select Format, Paragraph. Under Alignment, click on the drop-down menu and select Center.

68. Next, insert a running header. Click on View, Header and Footer. To right justify the header, click on Format, Paragraph. Under Alignment, click on the arrow for the drop-down menu and select Right.

69. Type in the author’s last name (use your own) and press the space bar once. Now you want to insert a page number. In the header toolbar, click on the page icon with the # symbol.

70. Finally, highlight the name and page number. Select the font and font size you want to use (Arial 12). Click on Close in the header toolbar when you are finished.

71. Arrow or scroll down to the second page of the document. There you will see a paragraph beginning “A hero, then. . . .” Delete the extra spaces before and after the paragraph by positioning your cursor in the blank line and pressing the Delete key.

72. This paragraph is a long (more than 5 lines) quote from another text. It needs to be inset one inch on the left margin. To do this, click and drag to highlight the paragraph. In the ruler, drag the left margin icon from its current position to the 1” marker.

73. Arrow or scroll down to the top of page 3 and repeat these steps for the paragraph beginning “We ought not to identify. . . .”

74. Arrow or scroll down to page 10 and find the words “Works Cited”. Position your cursor at the beginning of this phrase. Hold down the Ctrl key and press Enter. Release both keys. This creates a page break and puts the “Works Cited” section at the beginning of a new page.

75. Center the phrase “Works Cited”. Select Format, Paragraph and under Alignment select Center.

76. You need to double-space the Works Cited. Highlight from “Barthelme” to the end of the document. Select Format, Paragraph. Under Line spacing click on the arrow for the drop-down menu and select double.

77. Now you need to set a 1/2 inch hanging indent for the second line of each citation. With the Works Cited section still highlighted, adjust your left margin icons so that they appear like the one in the example below:
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The purpose of this day is for each participant to engage in a variety of activities that will allow him or her to produce and publish various findings. When students learn, they assess information, and then try to put it in some form that will help them to retain the learning. Many times this is a type of final project.
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1950


1955


1960
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Elvis Presley: "That's All Right"


Chuck Berry: "Maybellene"


Little Richard: "Tutti-Fruitti"


J.L. Lewis: "Whole Lot Of Shakin'"


Buddy Holly: "Peggy Sue"


Holly, Valens, Big Bopper Killed


Bob Dylan: "Freewheelin' Bob D."


Beach Boys: "Surfin' U.S.A."


Newport Rock Festival


Beatles: "Please Please Me"- GB#1


Film "A Hard Day's Night" Opens


Roy Orbison: "Oh Pretty Woman"


Beatles' Ed Sullivan Show Debut


Brown: "Papa's Got A Brand New..."


Otis Redding: "Respect"


Dylan: "Highway 61 Revisited"


Byrds: "Mr. Tambourine Man"


The Stones: "Satisfaction"


O. Redding: "Dictionary Of Soul"


Monterey International Pop Festival


Zombies: "Time of the Season"


Aretha Franklin: "I Never Loved A Man"


Janis Joplan: "Cheap Thrills"


Marvin Gaye: "I Heard It..."


The Stones: "Let It Bleed"


Woodstock Music and Art Fair


Elvis' Las Vegas Debut


Chuck Berry: "Have Mercy Judge"


Paul leaves the Beatles


Marvin Gaye: "Let's Get It On"
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